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WARRANTY 

TO THE CUSTOMER 

Thank you for purchasing this equipment from APOGEE LABS, Inc. Our intention is that the 

equipment meets your requirements and exceeds your expectations and you find our 

documentation adequately describes its operation and use.  We continue to strive for higher 

levels of quality in our products, services and customer support and look forward to hearing from 

you if you have any comments or questions regarding these areas.  We sincerely believe that the 

customer comes first. 

WARRANTY 

APOGEE LABS, Inc. warrants its products to be free from defects in materials and workmanship 

for a period of 18 months from the date of shipment to the original purchaser.  APOGEE LABS 

Inc. obligation for any defect shall be limited to repair or replacement at our discretion of 

defective equipment.  APOGEE LABS, Inc. assumes no liability if defects result from improper 

use, repairs not made by APOGEE LABS, Inc., negligence, accident, mishandling or 

misapplication of the equipment.  No other warranty is expressed or implied and APOGEE 

LABS, Inc assumes no liability for consequential damages.  Should a warranty repair be 

required, please contact APOGEE LABS, Inc. for a Return Authorization Number. 

EXTENDED WARRANTY 

APOGEE LABS, Inc. offers an extended warranty plan to cover equipment beyond the original 

18 month warranty.  Under the extended warranty, APOGEE LABS will repair or replace 

equipment and/or components which have failed under normal use at its sole discretion.  This 

extended warranty does not cover repair or replacement of equipment or components that failed 

because of improper use, repairs not made by APOGEE LABS, Inc., negligence, accident, 

misapplication of the equipment, or mishandling.  A one-year or multi-year Extended Warranty 

may be purchased.  Please contact our sales department for a price quotation. 
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 1  OVERVIEW 
 

ACxIS is a Java based, OS-independent program which controls the Apogee Labs AL2273 Digital 

Switch and the Apogee Labs AL2202 Analog Switch via Ethernet remote control.  ACxIS provides 

an intuitive interface for making and breaking connections as well as added features for building 

complex configurations. 

 

 2  DEFINITIONS 
 

ACxIS – Apogee Labs, Inc. Controller Interface Software 

ACK – Successful command issued to Node or Module, response contains:  ‘>’ 

NACK – Unsuccessful command issued to Node or Module, response contains: ‘?’ 

 

 3  REQUIREMENTS 

      

Operating System:   O.S. Independent - Windows XP, Linux 

Minimum Resolution: 1024x768 

Java:    1.6.0 or higher (The ACxIS installation program will install if 

                                                missing or a prior version.) 

Processor:   1 GHz or higher 

Ram:    256 MByte minimum 

Hard Drive:   100 MBytes free space minimum 

Remote Interface:  Ethernet 
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 4  INSTALLATION  
 

To install ACxIS on a Windows system, place the ACxIS CD into the computer’s CD or DVD 

reader. If the computer is not configured to automatically open a file browser for the CD, open a file 

browser to view the CD’s contents. Locate the ACxISInstaller.exe file and double click on it. The 

installation can be launched also by typing in the command line the CD directory and 

“ACxISInstaller.exe”, ex. D:\ACxISInstaller.exe  

 

The ACxIS installation process will begin by checking the version of Java which is installed on the 

system. If there is either no Java installed or the Java installed is a version prior to 1.6.0, Java 1.6.0 

will be installed on the system. Once the Java installation is verified, the installation program will 

start the installation of the ACxIS software. 

 

 
Figure 1: Windows ACxIS Installation Welcome Screen 

 

After this dialog appears, click next for installation or cancel to abort the installation.  There are no 

other settings beyond this point and clicking next will begin installing files on the computer. 
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To continue installation, you must select the “I accept the terms in the License Agreement” option 

from the End-User License Agreement dialog to enable the Next button at the bottom of the window. 

 

 
Figure 2: End-User License Agreement 

 

Next, click on the Install button that appears on the next screen to begin the installation. 

 

 
Figure 3: Windows ACxIS Installation Ready to Install 

 

Once the installation is finished, the final dialog presents you with two options.  The first option is to 
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View the readme file (which displays a copy of the Manual) and the second option is to Launch 

ACxIS which starts the program. 

 

 
Figure 4: Windows ACxIS Installation Complete 

 

4.1  INSTALLATION LOCATION 

 

The installation files will be installed under the C:\Program Files\ACxIS or C:\Program Files 

(x86)\ACxIS directory. 

 

4.2  INSTALLATION FILES 

 

The installation consists of the main ACxIS binary file, all required graphic images, and the 

supporting documentation. 
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4.3  DESKTOP SHORTCUTS 

 

During installation a desktop shortcut will be automatically created.  If controlling multiple switches, 

you can create multiple desktop shortcuts that link directly to each switch.  Copy and paste the 

original shortcut, renaming the new copy for your specific device.  In order to configure your 

shortcuts to point to a specific switch, you need to modify the shortcut properties to pass the IP 

Address and (optionally) NNAT Port number to the ACxIS program. 

 

In order to make the required changes: (see Figure 5) 

- Right click on your new shortcut 

- Select the “Properties” entry. 

- Move your cursor to the field labeled “Target:” 

- After the program name (e.g. "C:\Program Files\ACxIS\ACxIS.exe") add the IP address of 

the device that you want to connect with, and then optionally the NNAT port. 

 

Example: "C:\Program Files\ACxIS\ACxIS.exe" 192.168.0.111 

 

 
Figure 5: Shortcut Properties 

 

The application’s connector colors, color legend, matrix size, enabled options and application 

window size are associated with the IP Address, enabling you to customize the setup for each 

shortcut that you create. 
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 5  MENUS 
 

5.1  DROP DOWN MENUS 

 

The menu bar for the Remote GUI has drop down menus with the following options: 

 

5.1.1 File 

 

 
Figure 6: File Menu 

 

New:   This option closes the current configuration and creates a new configuration with 

default settings.  If the current configuration was modified and not saved, a dialog 

will appear with the options to either save the configuration or to discard the changes.  

 

Open:  This option opens a file chooser dialog that allows for the selection of a configuration 

file to open. 

 

Save/Save As:  This option opens a save file dialog that allows the current configuration to 

be named and saved. 

 

Print:  This option prints the currently displayed page. 

 

Advanced Configuration:  This option opens the Advanced Configuration window which 

allows the user to specify where program settings files are stored, and other advanced 

configuration options. 

 

Quit:  This option closes the program. 
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5.1.1.1 Advanced Configuration 

 

 
Figure 7: Advanced Configuration Menu 

 

This dialog window provides the user some advanced configuration options.  The first two 

entries are related to the location in which ACxIS configuration files are stored.  These 

configuration files save the options, IP configuration and BNC colors for switches, 

referenced by each switch’s IP address.  The last entry is related to suppressing confirmation 

prompts for certain activities. 

 

Global Parameter Location:    
There are two choices for the option:  Save Locally and Save Globally. 

 

Save Locally: 

 This choice is the default operational mode, and how earlier versions of 

ACxIS used to operate.  Choose this selection if you do not have the need to 

share configuration files and setups with other users.  The files will be stored 

in a hidden directory named .ACxIS which is located in the user’s directory. 

 

Save Globally: 

 This choice is used if you wish to share configuration files and setups with 

other users.  You need to have a systems administrator configure a directory 

that is accessible by all users who wish to access these files.  This directory 

must then be entered into the Global Parameters Path field. 

 

Global Parameters Path:   
This field contains the directory that will be used for the ACxIS configuration files, if 

you select the Save Globally option above.  You can manually enter the path into this 

field, or use the Select Global Dir button to open a file chooser dialog to select the 

directory. 
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Disable Verification Prompts:   
This option is used to disable verification / confirmation prompts that normally occur 

when configuring a switch.  When this option is unchecked, the system operates as 

normal.  When this option is checked, the user will no longer be prompted for 

confirmation for certain operations, such as when moving connections, overwriting 

connections, deleting connections, or exiting the application.  This is an advanced 

option and should not be enabled unless the user is an experienced ACxIS user. 

 

5.1.2 Remote 

 

 

 
Figure 8: Remote Menu 

 

Connect:  This option will connect to the switch as configured by the Connection Options.  

If connecting to a switch which requires a login, make sure the User Name is set 

under the Connection Options.  Also, when connecting to a switch which requires a 

login, a popup will appear requesting the password for the user. 
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Connect Options:  This will display a popup window showing the IP Address, Port Number, 

and User Name that will be used to connect to the switch.   

 

The user name is needed when connecting to a switch which requires a login, such as 

the AL2273-203 and the AL2202.  (The AL2273-203 and the AL2202 also need to 

have telnet enabled.  See the troubleshooting section for additional information.)  The 

checkbox next to the Save Password field will store the entered password if enabled. 

 

If controlling multiple switches, see Section 4.3 for information on creating multiple 

desktop shortcuts. 

 

 
Figure 9: Connection Options 

 

 

Disconnect:  This option will disconnect from the switch. 

 

 

Load File:  This option will load a local configuration onto the switch, but will not save the 

configuration on the switch.   

 

 

Transfer File:  This option will transfer a local configuration onto the switch without 

modifying the current configuration of the switch.   

 

*Note: The Load File and Transfer File options are not available for the AL2202.  Please see 

section 7.5 Partial Files for comparable upload options. 
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5.1.3 Options 

 

 
Figure 10: Options Menu 

 

Offset Lines:  This option when selected will display connection lines to be offset by row 

when the Matrix page is expanded to have at least 64 connecters in each row.  If the 

program cannot be expanded to that extent the connection lines will be drawn from 

the center of each connector. 

 

Show Both Paired Lines:  This option when selected will display both lines of a paired 

connection.  If this option is not selected only the line between the odd numbered 

connectors will be displayed for a paired connection. 

 

Show Connection Numbers:  This option when selected will display the connection number 

and name in the connection popup that appears when hovering over a connector.  If 

this option is not selected only the connection names will be displayed. 

 

Show Rows of 16:  This option when selected will display the connectors in rows of 16.  The 

window will allow scrolling for displays that cannot display all 32 rows. 

 

Edit Connector Colors:  This option when selected will allow the user to edit the 

background colors of connectors in the matrix. 

 

Connection Hover Options:  This option opens a dialog window that allows the user to 

modify the font size for the text in the connection popup that appears when hovering 

over a connector. 
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5.1.4 Matrix Size 

 

 
Figure 11: Matrix Size Menu 

 

This menu option allows the user to configure ACxIS to show the correct number of input 

and output connections to correspond to the hardware that you are connecting to.  After 

switching modes, a restart of the application is required to reconfigure the interface. 

 

5.1.5 Help 

 

 
Figure 12: Help Menu 

   

Help:  This option displays this Instruction Manual. 

 

About:  This option displays contact information for Apogee Labs and the current version 

number of ACxIS. 
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5.2  MENU SHORTCUT KEYS 

In addition to selecting the menu options with the mouse, there are control-key shortcuts 

available for certain options.  Here is a list of the available shortcut keys: 

 

Ctrl + c:  Shortcut to connect to the switch. 

 

Ctrl + d:  Shortcut to disconnect from the switch. 

 

Ctrl + l:  Shortcut to open the load configuration file dialog. 

 

Ctrl + t: Shortcut to open the transfer configuration file dialog. 

 

Ctrl + n:  Shortcut to create a new configuration. 

 

Ctrl + o: Shortcut to open a configuration file. 

 

Ctrl + p:  Shortcut to print the current view. 

 

Ctrl + s: Shortcut to save the current configuration file. 

 

Ctrl + h:  Shortcut to display the Help file. 

 

Ctrl + q: Shortcut to quit the program. 
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 6  SETUP 
 

The setup page provides access to modify the input and output names, modes and pairs.  It also 

provides access to the IP configuration of the unit and the ability to save and load files which reside 

on the switch. 

 

 
Figure 13: ACxIS Setup Screen 

 

6.1  INPUTS 

 

Under the Inputs view, ACxIS provides the ability to rename, set the mode and pair inputs.  Names 

can be 1 to 16 characters in length.  The modes for inputs are Normal, Test PRN Data and Test PRN 

Clock.  Even numbered inputs can be set to either Test PRN Data or Normal.  Odd numbered inputs 

can be set to either Test PRN Clock or Normal.  

 

Consecutive inputs can be paired so that they follow the same path along the backplane to the paired 

outputs.  This reduces the amount of latency between the two outputs. 

 

*Note: Test modes are only available for AL2273-201 controller chassis. 
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6.2  OUTPUTS 

 

Under the Outputs view, ACxIS provides the ability to rename and pair outputs.  Names can be 1 to 

16 characters in length.  Consecutive outputs can be paired so that they follow the same path along 

the backplane to the paired inputs.  This reduces the amount of latency between the two outputs. 

 

6.3  IP CONFIGURATION 

 

The IP Configuration is populated when connected to the switch.  To modify the IP Configuration of 

the switch, enter the IP Address, Netmask and NNAT Port and click the Commit button.  If the IP 

address changes, ACxIS will be disconnected from the unit and the Remote->Connection Options 

will need to be modified to reconnect to the switch. 

 

6.4  SAVE/LOAD 

 

When connected, this field is used to save the current setup in the switch’s memory to the switch’s 

configuration files.  Enter the name to save and click on the Save On Switch button.  The newly 

saved file will be added to the Files On Switch list. 

 

6.5  FILES ON SWITCH 

 

This field will display the configuration files which are saved on the switch.  To delete a 

configuration file, click on the configuration file and click the Delete File button.  To load a 

configuration file, select the file and click on the Load File button.  This will load the configuration 

as the current configuration. 
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 7  MATRIX 
 

 
Figure 14: Matrix Setup Screen 

 

The Matrix setup page provides access to the switching matrix.  It allows users to make and break 

connections by utilizing a point and click interface to make connections between inputs and outputs.  

Once a connection is made a line is drawn between the corresponding input and output.  Every 

connection from a particular input will have the same colored line if an input is connected to more 

than one output. 
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7.1 EDITING CONNECTOR COLORS 

 

To edit the background colors of the connectors follow the procedure outlined below:  

 

1. Under Options menu, enable “Edit Connector Colors” 

 

 
Figure 15: Edit Connector Colors - Enable Edit Mode 

 

2. When in “Edit Connector Color” mode, you will not be able to set connections. Every 

connector you click on will become highlighted.  

 

 
Figure 16: Edit Connector Colors - Click to Highlight 
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3. Once you have a bank of connectors selected, right click and choose the color to change to 

(Red, Blue, Green, Yellow, Orange, Purple). 

 

 
Figure 17: Edit Connector Colors - Right Click to Select Color 

 

4. To change the connector back to white, double click the desired connector while in Edit 

Connector Colors mode. 

 

5. To leave the “Edit Connector Colors” mode, simply disable it under the Options menu. 

 

 
Figure 18: Edit Connector Colors - Disable Edit Mode 
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7.2 EDITING COLOR LEGEND 

 

To edit the Color Legend, simply click on the color you want to edit and type in the window.  

Modified entries are saved when the program closes and will be re-populated the next time the 

program is started. 

 

 
Figure 19: Edit Color Legend 

 

7.3 MANAGING CONNECTOR COLORS FOR MULTIPLE SWITCHES 

 

The connector colors, color legend, matrix size, enabled options, connection options and application 

window size are associated with the currently configured IP Address.  If the current IP Address is 

changed under the Remote->Connection Options menu, the settings associated with the new IP 

Address will be loaded.   

 

If the user configures the Global Parameter Location (on the Advanced Configuration Options 

dialog) to be Save Locally, the configuration files containing the setup information will be located in 

flat text files located in the current user’s home directory under the .ACxIS directory ( 

C:\Users\<user_name>\.ACxIS ).  If the user configures the Global Parameter Location (on the 

Advanced Configuration Options dialog) to be Save Globally, the configuration files containing the 

setup information will be located in flat text files located in the directory that is selected in the 

Global Parameters Path field. 

 

The color settings are located in files named bncColors_<ip_address>.txt , the IP settings are stored 

in files named IP.setup_<ip_address>.txt and the other settings are in the files named 

options.saved_<ip_address>.txt .  If the user wants to migrate settings from one IP Address to 

another, the <ip_address> portion of the files can be modified to match a different IP Address.  The 

contents of these files can also be copied and pasted into other files as a basis for modification. 
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7.4 EDITING CONNECTIONS 

7.4.1 Lock/Unlock the Matrix 

 

To begin editing the connections, click on the Edit Matrix button.  When finished modifying the 

connections, click on the Finish Edit button and the connections will again be locked out from 

accidental modifications.  When editing is locked out, the Hide All and Show All buttons are still 

active, as well as the toggle lines option when right clicking on a connector with an active 

connection.   

 

7.4.2 Add Connections 

 

 To add a connection, click on the input then click on the output.  A new line between the input and 

output will appear to indicate the input and output are connected.  To connect multiple outputs to a 

single input, the input does not have to be clicked between outputs.  For example, clicking on input 1 

then outputs 1, 2, 3, and 4, will connect input 1 to outputs 1 through 4.  If the inputs and outputs are 

paired, the consecutive input and output are also connected.  For example, if input 1 and 2 are paired 

and output 1 and 2 are paired, clicking on input 1 then output 1 will connect the two inputs and 

outputs. 

 

Note: Paired inputs cannot be connected to un-paired outputs and vice-versa. 

 

As the matrix view begins to fill with connections, it may become difficult to see which inputs are 

connected to which outputs.  Clicking on the Hide All button will place draw all connections as 

thinner grey lines.  To view an input’s connection lines as normal, right click on the input and select 

toggle lines.  Another method to view connections is to click on the leading input number text field 

of each row of BNCs.  This will display all connections contained in the selected row of input 

connectors. 
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7.4.3 Delete a Single Connection 

 

To delete a single connection, right-click on the output and select the Delete Connection option.    A 

popup message will be displayed asking for confirmation of the deletion, unless you have the 

advanced configuration option of Disable Verification Prompts enabled. 

 

 
Figure 20: Delete Connection Right Click Option 

 

 

 

 

7.4.4 Delete All Connections to an Input 

 

To delete all connections to an input, right click on the input and select the Delete Connections 

option.  A popup message will be displayed asking for confirmation of the deletion, unless you have 

the advanced configuration option of Disable Verification Prompts enabled. 

 

7.4.5 Delete All Connections 

 

To break all connections on the switch, click on the Delete All button at the top of the window.  A 

popup message will be displayed asking for confirmation of the delete all action, unless you have the 

advanced configuration option of Disable Verification Prompts enabled. 
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7.4.6 Move Input 

 

To move an established connection or group of connections from one input to another, right click on 

the desired input and select the Move Input option.  To complete the move operation, click on 

another input connector.  A popup message will be displayed asking for confirmation of the move, 

unless you have the advanced configuration option of Disable Verification Prompts enabled. 

 

 
Figure 21: Move Input Right Click Option 
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7.5 PARTIAL FILE INTERFACE 

 

The Partial File Interface allows users to load multiple PCF (*.pcf) files on top of an existing loaded 

DMS or CFG file.  DMS and CFG files contain setup information about all input and output names, 

all input and output pairs, and all connections.  PCF files only contain information about connections 

and contain anywhere from 1 to 256 connections.  If utilizing the Partial File Interface the best 

practice would be to save all input and output names and pairs in a DMS or CFG file and to save all 

connections in PCF files as needed.  

 
Figure 22: Partial File Interface 

7.5.1  Partial File Window 

 

The Partial File Window displays all currently loaded partial files.  Clicking on a loaded file will 

show all the connections that are contained in that file and hide all other lines.  Multiple loaded files 

can be selected at the same time by pressing SHIFT or CTRL while clicking on files in the Partial 

File Window. 

 

7.5.2  Preview Partial File 

 

The Preview Partial File button opens a file chooser dialog that allows for the selection of a partial 

file to preview.  After a file is selected, that file will be displayed as visible lines on the Matrix and a 

confirmation will be displayed asking if the user wants to finish loading the partial file.  If No is 

selected the lines will be erased and no connections will be made.  If Yes is selected the lines will 

remain and the partial file will be loaded as normal. 
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7.5.3  Load Partial File 

 

The Load Partial File button opens a file chooser dialog that allows for the selection of a partial file.  

After a file is selected, that file will be loaded into the partial file window and all connections 

contained in the file will be made and displayed on the Matrix. 

 

7.5.4  Unload Partial File 

 

The Unload Partial File button will unload the currently selected partial file in the partial file 

window.  Before the file is unloaded a confirmation message will be displayed and will only 

continue if Yes is clicked.  If more than one file is selected in the partial file window a confirmation 

message will be displayed for each file before they are unloaded. 

 

7.5.5  Save Partial File 

 

The Save Partial File button will open a save file dialog that allows the user to enter a name for the 

partial file to be saved.  Only the lines that are visible will be saved as connections in the newly 

saved partial file.  Lines can be hidden and shown using the Hide All and Show All buttons, by 

clicking on the Hide Loaded Lines button, or by right clicking on input or output connectors and 

choosing the Toggle Line(s) option. 

 

If there are no lines visible when the Save Partial File button is clicked an error message will be 

displayed.  When a partial file is saved, it automatically gets loaded into the Partial File Window. 

 

7.5.6  Hide Loaded Lines 

 

The Hide Loaded Lines button hides all the lines in the Matrix that are contained in the currently 

loaded partial files and shows any lines that are not part of the currently loaded partial files.  This 

button is particularly useful if building new partial files on top of already loaded partial files.  

Instead of manually hiding and showing lines using the Toggle Line(s) option, the Hide Loaded 

Lines button will automatically show the newly added connections and hide all lines contained in the 

currently loaded partial files. 

 

7.5.7  Creating Partial Files 

 

To create partial files (PCF file) follow the example procedure outlined below: 

1. Ensure that there are no active connections by clicking the Delete All button if connected or 

File->New if not connected. 

2. Make desired connections and ensure that all lines are visible by clicking the Show All 

button. 

3. Click the Save Partial File button and enter a name for the new file.  Note that the newly 

saved file gets loaded in the partial file window. 
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4. To create another partial file on top of the last file, add more connections to the Matrix. 

5. Click the Hide Loaded Lines button.  Note that the last saved files lines get hidden and only 

the new connections are visible. 

6. Click the Save Partial File button and enter a name for the new file.  Note the newly saved 

file gets loaded in the partial file window. 

7. Click on each filename in the partial file window and notice that when each file gets clicked 

the lines corresponding to the connections in each file become visible while the other lines 

become hidden. 

 

7.5.8  Partial File Conflicts and Modifications 

 

When loading or unloading partial files ACxIS checks the current configuration against the partial 

file that is being loaded or unloaded and reports any configuration conflicts or modifications that are 

present. 

 

When there is a conflict between an established connection and a connection contained in a partial 

file that is being loaded a popup message will be displayed, unless you have the advanced 

configuration option of Disable Verification Prompts enabled. 

 

 
Figure 23: Conflicts Message 

 

If the user selects Yes the partial file takes precedence over any existing connections and any 

conflicts will be overwritten.  If the user selects No, the partial file will not be loaded.  If the user 

selects View Conflicts another popup message will be displayed containing more information about 

the conflicts. 

 

 
Figure 24: Conflicts List Message 

 

The conflicts list contains the existing connection and the connection contained in the partial file.  If 

the user selects Yes the conflicts will be overwritten by the partial file.  If the user selects No, the 

partial file will not be loaded. 
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When modifications have been made to connections contained in an already loaded partial file and a 

user wants to unload the partial file an error message will be displayed. 

 

 
Figure 25: Modifications Message 

 

If the user selects Yes, the partial file takes precedence over any existing modifications and any 

connection contained in the partial file will be deleted.  If the user selects No, the partial file will not 

be unloaded and no changes will be made.  If the users selects View Mods another popup message 

will be displayed containing more information about the modifications, unless you have the 

advanced configuration option of Disable Verification Prompts enabled.  If you have the advanced 

configuration option of Disable Verification Prompts enabled, it will automatically perform the 

Delete Valid action. 

 

 
Figure 26: Modifications List Message 

 

The modifications list contains the modified connections and the connections contained in the partial 

file.  If the user selects Delete All, the modified connections and connections contained in the partial 

file will be deleted.  If the user selects Delete Valid, only the connections contained in the partial file 

that have not been modified will be deleted.  If the user selects Cancel, the partial file will not be 

unloaded and no changes will be made. 
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7.6  SHOWING AND HIDING CONNECTION LINES 

 

7.6.1 Hide All / Show All 

 

 
Figure 27: Hide All & Show All Buttons 

 

The Hide All and Show All buttons located at the top right of the Matrix screen allow the user to hide 

all lines or show all lines by clicking on the appropriate button. 

 

7.6.2 Toggle Line(s) Right Click Option 

 

 
Figure 28: Toggle Lines Right Click Option 

 

The Toggle Line(s) option allows individual lines or groups of lines to be toggled between hidden 

and showing.  To access the Toggle Line(s) option simply right click on an input or output connector 

that has an active connection.   
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 8  CONNECTIONS 
 

 
Figure 29: Connections List 

 

 

The connections page will show the connections in a text-based list.  The inputs are listed on the left 

side by name and the list of outputs are listed next to the inputs.  
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 9  STATUS 
 

 
Figure 30: Status Page 

 

*Note: The Status menu entry and screen is not available when configured for the AL2202 switch. 

 

 

9.1  BER STATUS 

 

The BER Status shows the results of current and recent single channel tests. 

 

To run a BER test, first connect the input and output channels on the Matrix screen.  The input and 

output channels must be paired and the input channels must be set to Test PRN Data and Test PRN 

Clock.  Next select the output channel under the BER Status section.  After the output has been 

selected, the results will appear showing BER Errors, BER and BER Status.  To clear the BER 

Errors and BER, click on the Clear Errors button. 

 

*Note: The BER Status features are only supported by the AL2273-201. 
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9.2  SELF TEST 

 

The Self Test function permits testing the entire switch matrix for the presence of an error condition 

on any data path. This test may be run for a very long period (up to 1440 minutes and 59 seconds). 

The minimum time for this test is 8-seconds, which allows a one second test to be performed on each 

channel pair of a module. While the test is in progress an indication of Remaining Time is presented 

as well as the Self Test Status. The status indicates Off only if the test has not been executed since 

the application of power to the unit. Thereafter, the status indicates Halted, Running or Done 

 

The Self Test will configure the switch in a 1 to 1 configuration, i.e. input 1 is sent to output 1, then 

all of the channels are tested with the BER data and clock.  After the test has finished, the switch will 

return to the pre-test configuration.  To prematurely terminate a test sequence, activate the Halt Self 

Test button. This action terminates the test and no intermediate test results are presented. 

 

*Note: The BER Status features are only supported by the AL2273-201. 

 

9.3  SYSTEM STATUS 

 

Indication is provided for the health of each of the two power supplies, the connection status of the 

Ethernet Client port and the ubiquitous general system health LED that includes the combined state 

of all critical system components.  If the system status LED is not green while the power supply 

status indicators are green, the location of the out of tolerance switch condition is found viewing the 

Board Status section below the System Status button. This displays the presentation of the individual 

status for all of the switches. 

 

Should the display indicate that a switch module exhibits a failure mode, it is advisable to remove 

that module from service, either physically or logically. If a module is failed (Red LED), it may be 

removed from the status scanning process by clicking on the LED and uninstalling the board via the 

popup window.  A board is seen as uninstalled by a yellow LED. 

 

 
Figure 31: Uninstall Board 

 

The Ethernet Client LED indicates the existence or absence of a connection to the system from a 

remote user on the Ethernet connection. When the client is connected, the indicator is green and 

appears to be illuminated. When there is no connection, the indicator color tends towards black. 

As long as all LEDs are green no further investigation is needed.  
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 10  SAVING CONFIGURATIONS 
 

To save a configuration file, click on File from the menu bar then Save or Save As.   

 

 
Figure 32: Save Menu Option 

 

 

If the file has not been saved, or the Save As option has been selected, a Save As dialog will appear 

providing options to set a file name and save location. Configuration files are saved based upon 

which controller chassis is being controlled.  The AL2273-201 and AL2202 controller chassis save 

files with a .DMS file extension.  The AL2273-203 controller chassis saves files with a .CFG file 

extension. 

 

 

 
Figure 33: File Save As Dialog 
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Saving configuration files through the File->Save operation will save the current configuration 

locally on computer that ACxIS is installed or on a network drive.  To save configuration files on the 

switch itself reference Section 6.4.   

 

DMS files are saved in XML format with all Nodes and Modules included in each Node. NOTE: To 

avoid corruption of files, configuration files should not be modified outside of ACxIS. 

 

DMS Configuration File example 

Filename: Untitled.dms 

 
<DmsConfigData> 

 <DmsInputs> 

  <DmsInput number="1" name="INPUT-1"> 

   <Pair>false</Pair> 

   <Prn>off</Prn> 

   <Output>1</Output> 

  </DmsInput> 

  ... 

  ... 

  <DmsInput number="256" name="INPUT-256"> 

   <Pair>false</Pair> 

   <Prn>off</Prn> 

   <Output>256</Output> 

  </DmsInput> 

 </DmsInputs> 

 <DmsOutputs> 

    <DmsOutput number="1" name="OUTPUT-1"> 

     <Pair>false</Pair> 

</DmsOutput> 

  ... 

  ... 

  <DmsOutput number="256" name="OUTPUT-256"> 

   <Pair>false</Pair> 

  </DmsOutput> 

 </DmsOutputs> 

</DmsConfigData> 
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CFG files are saved in a flat text format with all Slot, Names, Pairs, and Connections. NOTE: To 

avoid corruption of files, configuration files should not be modified outside of ACxIS. 

 

CFG Configuration File example 

Filename: Untitled.cfg 

 
SYSTEM=AL2273-203 

SLOT1=Input 

1-1 Name=INPUT-1.1 

1-1 Paired=Off 

1-2 Name=INPUT-1.2 

1-2 Paired=Off 

... 

... 

SLOT32=Output 

32-1 Name=OUTPUT-32.1 

32-1 Paired=Off 

32-2 Name=OUTPUT-32.2 

32-2 Paired=Off 

... 

... 

SLOTCX=AL2273-203 

CONNECT OUTPUT 256=0 

CONNECT OUTPUT 257=1 

CONNECT OUTPUT 258=2 

CONNECT OUTPUT 259=3 

CONNECT OUTPUT 260=4 

CONNECT OUTPUT 261=5 

CONNECT OUTPUT 262=6 

CONNECT OUTPUT 263=7 

CONNECT OUTPUT 264=8 

... 

... 
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 11  OPENING CONFIGURATIONS 
 

Clicking on File then Open from the menu bar or Ctrl-o will launch the Open File dialog.  The Open 

File dialog will automatically display files with a .DMS or .CFG extension only. Other files can be 

viewed by selection “All Files” on the Files of Type dropdown menu.  This feature is only available 

when not connected to a switch. 

 

 

 
Figure 34: File Open Dialog 

 

 

Opening a file will only open the file locally and it will not be loaded on the switch.  If there are 

errors in the configuration, a popup will indicate an error and the configuration will not be loaded. 

 

 

 
Figure 35: File Format Error 

 

For loading and transferring files to the switch see section 12. 

 



Apogee Labs, Inc. ACxIS 

 

 

 APOGEE LABS, INC. 
               34      - 3410 - 

04.01.2019 

210 South 3rd Street, North Wales, PA 19454 

Tel: 215.699.2060  Fax: 215.699.2061 

E-mail: sales@apogeelabs.com   

 

 

 

 

 12  LOADING AND TRANSFERRING CONFIGURATION FILES 
 

 Loading configuration files from ACxIS will take a local file on the PC and loads it on the switch.  

When the file is loaded on the switch, it is not saved as a configuration on the switch until it is saved 

under the Save/Load section on the Setup page.  This action is not available when connected to an 

AL2202 switch. 

 

Clicking on File then Load from the menu bar or Ctrl-l will launch the Load File dialog.  The Load 

File dialog will automatically display files with a .DMS or .CFG extension only. Other files can be 

viewed by selection “All Files” on the Files of Type dropdown menu.  When a file has been selected, 

the Loading File progress will popup. 

 

 
Figure 36: Loading File 

 

 

 

Transferring configuration files from ACxIS takes a local file and transmits it to the switch.  This file 

is then saved as a configuration on the switch, but not loaded. 

 

Clicking on File then Transfer from the menu bar or Ctrl-t will launch the Transfer File dialog.  The 

Transfer File dialog will automatically display files with a .DMS or .CFG extension only. Other files 

can be viewed by selection “All Files” on the Files of Type dropdown menu.  When a file has been 

selected, the Loading File progress will popup. 

 

 
Figure 37: Transferring File 
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 13  DMS/CFG VS PCF FILES 
 

DMS and CFG files contain setup information about all input and output names, all input and output 

pairs, and all connections.  PCF files only contain information about connections and contain 

anywhere from 1 to 256 connections.  The partial file interface that implements PCF files is an added 

feature of ACxIS that allows users to build complex setups out of smaller setup files.  ACxIS uses 

PCF files to make and break connections on the switch based off the connections contained in each 

file.  The AL2273 controller can only ingest DMS or CFG files and cannot handle PCF files 

renamed as DMS or CFG files since the content contained in these files are very different.  See the 

below example of a PCF file in comparison to the example of configuration files in Section 10. 

 

PCF Configuration File example 

Filename: Untitled.pcf 

 
PARTIAL FILE 

CONNECT 1=3 

CONNECT 1=5 

CONNECT 1=7 

CONNECT 1=9 

CONNECT 1=11 

CONNECT 1=13 

CONNECT 1=15 

CONNECT 2=4 

CONNECT 2=6 

CONNECT 2=8 

CONNECT 2=10 

CONNECT 2=12 

CONNECT 2=14 

CONNECT 2=16 
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 14  PRINTING VIEWS 
Each of the four views, Matrix, Connections, Setup and Status can be printed as seen at the moment.   

 

 
Figure 38: Printed Setup 

 

Printing will not expand any scrollable views.  As seen in the figure above, printing will only show 

what is currently visible.   
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 15  TROUBLESHOOTING  
 

Issue: Cannot connect to an AL2202 or AL2273-203. 

Solution:   Verify that telnet is enabled on the target device.  You can enable telnet through the 

switch’s web interface.  Using the web interface, navigate to Module 9 on the left of the screen and 

then select the IP Setup tab from the main frame of the screen.  Use the pulldown menu to set Telnet 

to be Enabled.  Refer to the switch’s product manual for additional information. 

 

Issue:  Cannot save to a directory in Windows that appears to be writable. 

Solution:  Open up a command console and navigate to the directory one level above the one that 

needs to be modified and type: attrib -r <”directory name”> to permit ACxIS permission to that 

directory. For example: attrib -r “My Documents” 

 

Issue: Cannot open a configuration file. 

Solution:   Verify that the configuration file is not open in any other application.  

 

Issue: Can open a configuration, but cannot save modifications made to the file.  

Solution: Use a file browser or terminal to navigate to the location of the configuration file. Verify 

that the configuration file is not set to read only and that it’s not opened by any other application. 

After removing the read only flag from the file, try to save the file again. 


